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0. INTRODUCTION

Below you will find my personal survival guide for navigating personal computers through speech recognition.
I have compiled it over years as some sort of personal blog, taking note of useful software and tricks as they
came along.

I am posting it in the hope that other folks who are suddenly forced to abandon using keyboard and mouse
will realize that there is hope, and so others may benefit from little tricks that took me forever to figure out. A
lot of these are available elsewhere online, but I thought it might be useful to collect them together so that
they are easily available for new or less experienced users. Some of these I came up myself, although I
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would not be surprised this others before me have also documented them.

Wherever possible I have tried to link to the original source of the helpful material. I am grateful to the speech
recognition user community for their active and useful presence online. The various topics are presented in
order of importance in my opinion. I will not be able to maintain and update this regularly, but I do plan to
continue collecting interesting hints and tips, and if these additions reach critical mass I will try my best to
repost.

My personal story is that as a result of round-the-clock coding since a very young age I am no longer able to
use my hands to control a keyboard, mouse, iPhone/iPad, etc. So, I am forced to rely on speech recognition
exclusively. The positive message that I would like to convey is that if you invest in conquering the admittedly
very steep learning curve, you will be able to do the vast majority of the things that you need on a desktop,
and even be faster at some of them. A top-of-the-line machine with all the necessary software should cost
you less than $3000 and if your employer will not cover this cost you might be able to get financial assistance
elsewhere.

I have no commercial interests of any kind in any of the programs or suggestions mentioned below.

You will note that some of the useful tricks below rely on free third-party software. To the extent that you can,
please donate to the authors of the software.

Good luck to everyone!

1. NUANCE & DRAGON NATURALLYSPEAKING 11.5

As an end-user, I find this piece of software insanely good and was very pleasantly surprised at how well it
worked right out of the box. Accuracy is just plain amazing when the software is set up with all the right
hardware. As far as speech engines go, I am personally really glad that a company has been able to invest
all the resources required to make such a consumer product possible. While I find the user control interface
lacking for folks that have to rely completely on voice, this is easy to fix with third-party add-ons.

2. "UTTER COMMAND" BY REDSTART SYSTEMS

General Control of the PC, Including Mouse Commands, Multiple Monitor Control, Etc.

The third-party add-on "Utter Command" by Redstart Systems.  I was completely desperate when I found
this, mainly frustrated by how cumbersome it was to control the mouse using "MouseGrid". Of all the
third-party add-ons that I could find this was the only one that clearly stated that it had multiple monitors
support so I decided to give it a shot.

I have since been completely switched to using the Utter Command interface and I must say that it is a
lifesaver. I find it as critical as Dragon itself, and I say this because Dragon was unusable for me prior to Utter
Command since I was unable to control the mouse or browse the web satisfactorily with speech alone.  I
have not tried other third-party add-ons, so unfortunately I cannot comment on those, but I can tell you what I
consider to be the absolutely killer features of this product:

-  Built-in structure behind the commands, so that once you learn the structure you are able to guess new
commands that you need on-the-fly, and they work on the spot.

- Very careful consideration for the choice of words in the commands, leading to what I consider to be the
absolute shortest possible commands with words that are the easiest to pronounce.
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 - Stackable commands, where up to three commands in a row can be issued as a single command saving a
tremendous amount of time. For example, you can right-click, press a letter, and press enter, all with a single
intuitive stackable command.

 - Repeatable commands, with very intuitive repetition structure, e.g., "Down - Home - Paste - Repeat 4"

- Extendable interface where the user can take advantage of a provided wizard to very easily extend Utter
Command with the user's own commands. An extremely powerful component of this interface gives you the
ability to click predefined areas within a window, thus allowing you to control pretty much any piece of
software. For example, you can "bookmark" the play button in the QuickTime player so that any time you
want to hit it going forward you can simply say something like "QuickTime Play Local". What makes Utter
Command extremely powerful is that this "bookmarking" of different buttons and locations within any window
can be done without any programming and entirely by voice in a very easy, quick and seamless fashion.

 - Great set of commands for working with Microsoft Excel.

 - Tremendous documentation which is both thorough and well-organized. The provided manuals and
instruction go well beyond Utter Command and are the best documentation that I have seen for how to best
use speech recognition. I strongly recommend reading all 10 lessons cover to cover.

A quick note for folks with basic programming skills: the voice macros that comprise Utter Command are
easily accessible to the user through a set of nicely organized files. Even without any knowledge of voice
macro programming it is quite easy for a user to write their own custom macros by simply copying and
pasting code from the Utter Command voice macros. The level of programming skill needed to take
advantage of this is quite basic, similar to what's needed for a very high level programming language. Much
closer to Visual Basic than any low-level or object oriented languages.

Finally, Kim Patch, the founder of Redstart Systems, is extremely approachable, helpful, and a great
advocate for folks with disabilities that need to rely on speech.

2B. LEAP MOTION HANDS-FREE MOUSE ALTERNATIVE

https://www.leapmotion.com/

The leap motion controller has not yet been released but it looks so amazing that it may revolutionize
computer control for those who cannot use a keyboard and mouse due to RSI.

3. THIS ONLINE FORUM

I am posting this message in both this and the other online speech forum. For reasons unbeknownst to me
the two forums don't seem to like acknowledging each other explicitly, but from my perspective they have
both been a phenomenal resource, especially in the days of using Windows XP professional which were
fraught with a lot of problems.

I'm especially grateful to all the regular contributors and the folks that have put in the time to make this forum
possible. For me personally, reading Chucker's contributions has been particularly illuminating, especially
given his understanding and access to Nuance. So, I want to especially thank him for patiently explaining
things thoroughly and let him know that the non-expert users among us particularly appreciate his efforts.

4. WEB BROWSING
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Firefox + Mouseless browsing Firefox add-on + Utter Command = lifesaving. This combination allows you to
browse the web extremely efficiently by voice. Every link is turned into a number, and you click links by
simply calling out the number using a command such as "4 5 go". An especially nice feature of Utter
Command is the ability to click on two links using a single command, e.g., "4 5 go - 3 2 go", which is very
useful when filling out forms.

Mouseless browsing might occasionally interfere with sites that feature dynamic links. For example, when
mouseless browsing is turned on, the keyboard shortcut "D -> 7" malfunctions in Yahoo! Mail and opens up a
new tab (it's supposed to move the current message to your seventh favorite folder). Overall, I have found
that the inconvenience from these occasional snafus is far outweighed by the benefit of browsing so quickly
and efficiently in Mozilla Firefox.

While nothing remotely as convenient as mouseless browsing exists for the Google Chrome browser, I
mention on alternative below in the section regarding "Adobe flash".

Also, I very highly recommend the Firefox extension "Customize Your Web" which is by the same author as
Mouseless Browsing. It allows you to very easily customize how webpages behave. For example, I use it to
automatically bring the focus inside the search box in some pages, and also to greatly simplify how Google
search displays its results while introducing trivial keyboard navigation between search results and even
pages of search results. For a good sense of the capabilities of this add-on is definitely worth it to watch the
video on the extensions website.

5a. MICROPHONE

As suggested by Redstart Systems "ideal speech computer", after trying several high-end microphones I
went with the Sennheiser ME3  microphone and the resulting improvements in performance were immediate
and dramatic. I recommend using it with the long cord as sold by Emicrophones.com and connected via the
Buddy 7G USB sound pod (has a very convenient mute switch, and is also available with a long or short USB
cord). Do not use wireless microphones, not even the high-end ones, they are not even remotely comparable
to the experience from the combination listed here.

I have found that sometimes using the mute switch will result in some delays immediately after the
microphone has been un-muted. So, I very much prefer using the "go to sleep" command instead, especially
after modifying the wake-up command (see explanation below).

The only downside that I can think of with this microphone set up is that both of my Windows 7 systems
(described below) after lengthy periods of inactivity completely ignore the Buddy 7G USB sound pod both as
a microphone and as a headset (as verified by the "recording devices" Windows dialog), and this cannot be
fixed by a reboot alone. My solution to this problem (in case other folks are struggling with it as well) is the
following:

. Exit Dragon

. Unplug the microphone

. Reboot the PC, cancel out of the check microphone Wizard, and exit Dragon

. Plug the microphone back in, and check that it is working via the "recording devices" Windows dialog

. Rebooted the PC and let Dragon start as usual

An extremely useful feature of the Buddy 7G USB sound pod is the free software it comes with which allows
you to program the mute button on the microphone. For example, I have programmed a single click to send
the "control alt delete" command which allows me to bring up the password entry dialogue for logging into
Windows after reboot. Similarly, I have programmed a double-click to send the string of my password
followed by Enter, which allows me to login. Between those two new actions, I now very rarely have a excuse
to use a keyboard or a pointing device.
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There are a few more actions of that single button that can be programmed, and the user interface is quite
easy to understand and flexible enough to allow even voice commands to be associated with the mute
button. Once you have created your desired actions to be associated with different controls of the mute
button, do not forget to both save the actions to the profile, and also upload them to the device by clicking on
the corresponding icons shown to the right of the profile name.

5b. RESTARTING DRAGON BY VOICE, REBOOTING WINDOWS BY VOICE

Folks with disabilities which restrict them to only using voice and are unable to click on buttons, or folks with
machines where Dragon occasionally refuses to exit completely, may want to check out the following
extremely useful utility:

http://www.pcbyvoice.com/shop/pcbyvoice-speechstart/

which allows you, among other things, to start Dragon NaturallySpeaking by voice even if it has locked up.

I use this software myself and I have found it to be a fantastic utility which worked immediately after
installation on my Windows 7 laptop. I find it extremely useful for restarting Dragon by voice during voice
macro development or after it has hang up or after it has refused to exit completely leaving behind the
NatSpeak process. In my PC, the latter situation happens quite a bit and the tip that I found in the forums of
first exiting all open applications did not help.

That created a problem because when it occurred it prevented me from rebooting my PC using voice alone
which is sometimes the only way to fix occasionally erratic behavior by Dragon NaturallySpeaking. Now that I
have SpeechStart , however, after the initial failed attempt to exit Dragon I am able to restart Dragon with
SpeechStart which then allows me to successfully reboot the computer using the Dragon command "Restart
Windows Immediately". I would also like to mention that the author of the software, Lindsay (monkey8), is a
frequent contributor of very useful information to the online speech forum for which I am very grateful.

Finally, I have also found that liberal and frequent use of the "check microphone" wizard, especially after
noisy sessions, can help improve performance.

6. HARDWARE AND OPERATING SYSTEM

I noticed a huge improvement in performance when going from this system:

Dell OptiPlex 760, Windows XP Professional,  service pack 3,  3 gigabytes of RAM, Intel core duo CPU
@2.66 gigahertz, traditional hard disk drive

To this system:

Lenovo X 1 laptop, Windows 7 professional, 8 gigabytes of RAM,  Intel I5 with 3 megabytes of level III cache
@ 1333 megahertz, 138 GB solid-state drive

The laptop is extremely zippy, quite stable, and seems to operate equally well on battery or plugged in.
Beyond that, I do not notice any increase in performance when going from the Lenovo laptop to the following
custom desktop:

Windows 7 ultimate, 16 gigabytes of RAM, Intel I7 @ 3.4 gigahertz processor, also with a solid-state drive.

I have used both my desktop computer and the laptop with three monitors and both seem to handle this set
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up quite well. In both cases, I use three 19 inch monitors in a row extending my desktop across all three, and
control the movement across monitors seamlessly by using the commands made available by Utter
Command (e.g., to click in the middle of the third monitor I simply say "3 50 by 50"). I do not use the monitor,
keyboard, or trackpad of the laptop, I just keep it shut the whole time.

I do want to point out that if you're using the Lenovo port extender called "display link" it can be quite finicky,
especially as it relates to multiple monitors. So be prepared to tinker with multiple driver installations or at
least have access to a competent IT department if you're planning on using multiple external monitors with
the above laptop and the display link accessory. You may also need to go through a couple of these units
until you find one that works well.

On both the Windows 7 laptop and the Windows 7 desktop I have tried opening up to 20 windows at the
same time and have never noticed any degradation in performance. These windows include multiple
instances Microsoft office/Word/PowerPoint 2003, Firefox, Internet Explorer, chrome, Lotus Notes,
Bloomberg terminal, Notepad, WordPad, and statistical software. I have also added billions of custom voice
macros to Dragon, on top of Utter Command, without any effect on performance. I have never seen my
memory usage exceed 3.5 GB.

In general, I have found Windows 7 to be a dramatic improvement in stability and robustness, especially as it
relates to Dragon NaturallySpeaking 11/11.5. Various impossible to fix problems that I used to have in
Windows XP, such as Natural Language Commands stopping to work in Lotus Notes 7 & dictation stopping
to working Microsoft Word 2003, have never reared their ugly head since I moved to Windows 7. And this
was not for lack of trying in Windows XP, I had applied all the remedies that I could find anywhere, including
the dreaded ctfmon.exe, etc. etc.

7. REMOVE ADOBE FLASH PLAYER

In both of my Windows 7 machines Adobe flash player led to a dreaded "SendKeys canceled" Dragon error
which proved impossible to recover from by any other means other than removing the Adobe flash player.

The good news is that you do not have to give up on viewing Adobe flash content if you choose to not install
the Adobe flash player. A very good alternative is to use the Google Chrome browser to view (which does not
require a separate installation) for viewing/content. It is also a very stable browser in my experience. The
downside is that there does not exist a mouseless browsing extension for Google Chrome. However, an
adequate replacement is the Google Chrome add-on called "vivium", which can be customized to only show
numeric links. Once you have changed the settings for numeric links you simply have to press the letter "f"
for the numeric links to show up, and then you simply have to type in the link number followed by the enter
command (e.g., if you're using Utter Command, the command sequence for clicking on the 11th link would
be: "letter foxtrot" - "one one enter-short"). And, you have an additional feature which is not available with
mouseless browsing Firefox, the ability to open a link in a new tab by voice (replace "letter foxtrot" with
"uppercase foxtrot").

If you decide to give up the Adobe flash player for stability reasons you can remove the unknowing yellow
information bar in Firefox warning about missing plug-ins for the following instructions:

http://kb.mozillazine.org/Disabling_yellow_plugin_bar_-_Firefox

8. CHANGE THE "WAKE UP" COMMAND

As many people have noted in online forums Dragon's "wake up" command often seems to get invoked by
unrelated regular conversations or even background noise. Thankfully, various postings have pointed out that
Dragon Professional version has a file which can be edited and which controls the behavior of the "wake-up"
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command:

C:\ProgramData\Nuance\NaturallySpeaking11\Data\Enx\dvcu\general\system.dvc

I changed my wake-up command a long time ago to something short but which includes numbers and a
word, e.g., "123 hello", and have not had a single false wake-up by Dragon since.

Please note that a more robust and flexible alternative is offered by PCbyvoice SpeechStart software which
is mentioned in the microphone section above.

9. FILE BROWSING IN WINDOWS 7

The major complication in the Windows 7 version of Windows Explorer is the new Windows Explorer toolbar
that interferes with the familiar Windows XP method of switching between the panes by repeatedly hitting the
tab key. Thankfully, this toolbar can be disabled using the following instructions:

http://www.sevenforums.com/tutorials/65416-window-explorer-toolbar-remove.html

The toolbar removal only works  with aero  themes  in Windows 7, but not with the very light "Windows
Classic" theme. I have been using the default "Windows 7" theme and have not noticed any impact on
performance relative to the "Windows classic" theme.

In addition, there is an extremely useful third-party software called "classic shell". It restores most of the
familiar Windows Explorer and start menu behavior from Windows XP, while also fixing some annoyances. I
strongly recommend going through everyone of the "advanced settings" both for "classic Explorer" and for
"classic start menu". Some of the features that I like the most are:
 - the ability to see all the files as a list (View -> List) but still be able to sort by "name" or by "date modified",
etc. by voice.
 - Being able to remove the search box from the Windows Explorer window
 - being able to make the search box in the classic start menu be the default location where you land when
you press the start menu button but still being able to navigate up and down the menu. You can dictate into
the start menu search box in Windows 7 and that makes it very easy to find any program you like.

10. PDF FILE VIEWING

Prior to switching to Windows 7 and Dragon NaturallySpeaking 11.5, I had a fair amount of problems using
Adobe reader. However, with the version that I am using currently, 11.0.1, I have been quite happy and I
especially like the new feature where the cursor is automatically placed in the document making it easy to
select text. I have tried other, lighter and faster readers but I found them all to be much slower than Adobe
reader when it came to printing to our network printers.

11. SWITCHING WINDOWS & CONTROLLING TRAY ICONS

Application that numbers all the window icons in the taskbar and all the tray icons as well:

http://rammichael.com/7-taskbar-numberer

Was developed to work with Utter Command's "Window 6" & "Tray 3" commands, but will be useful generally
for any voice macro that switches to Windows or tray items by using keyboard shortcuts that count them left
to right.
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12. WEBMAIL

Keyboard shortcuts for Web mail programs, of which I find Yahoo mail easiest to use

13. NATURAL LANGUAGE COMMANDS FOR MICROSOFT OFFICE 2003 & LOTUS NOTES 7

The book "Dragon NaturallySpeaking for dummies", especially the sections on Natural Language
Commands. The other sections are fine too, but I prefer the Utter Command way for controlling everything
else except for Microsoft Office (where I like to use a mixture of Utter Command and Natural Language
Commands), and Lotus Notes 7 (where I like to use a mixture of Natural Language Commands and custom
Dragon commands that I have defined in the "Command Browser")

14. SELECT-AND-SAY ENABLED PROGRAMMERS TEXT EDITOR WITH HIGHLIGHTING

Despite numerous hours of effort, and having tried tens of programmers editors, I have been completely
unable to get any programmers editor to become Select-and-Say enabled with Dragon NaturallySpeaking
11.5. The closest I have gotten has been older versions of Notepad++ but, at best, they work only at times
and show very unpredictable behavior.

For folks that are interested in trying their luck at their own machine (the forums suggest that some people
have better luck than others) here is the webpage with instructions:

http://web.archive.org/web/20060223095959/speechwiki.org/SR/CustomEditControlsDatabase.html

For now, the closest I can get is to use Microsoft Word as a programmers editor by following the instructions
very kindly provided here:

http://reagle.org/joseph/blog/technology/making-word-useful

You will have to determine the regular expression that works for your programming language. For example,
for C style comments that expression is:

(/\*([^*]|[\r\n]|(\*+([^*/]|[\r\n])))*\*+/)|(//.*)

courtesy of this very useful website:

http://ostermiller.org/findcomment.html

In my experience, this has proven to be a quite satisfactory alternative.

You will also need a good view of the code that does not look like a legal memo. Here are the settings that
work for me:

 - Work with the "web layout" view (Dragon Natural Language Command: "View Web Layout"). I prefer this
view because it hides all whitespace formatting and even hides the page breaks.
 - Set the font to Consolas 10 point inside the AutoOpen() macro
 - Set the Default Tab Stops to 0.16 under Format => Tabs and save that setting to normal.dot, which
corresponds to the equivalent of two spaces for each tab given the font choice above
 - Set the "after" spacing to 0 under Format => Paragraph and save that setting to normal.dot

15. ELIMINATING THE "ENTER" STEP FOR CERTAIN ACTIONS
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There are some actions, such as browsing files or executing searches after the text has been entered in
search boxes, where the user dictates some text and then dictates the command "enter". The alternative is to
do this in one step by simply finishing off the dictated text with the "new line" in-line command, courtesy of
Kim Patch's Utter Command blog:

http://redstartsystems.com/blog/2011/01/14/friday-tip-creative-new-line/

Here are some examples where this trick really helps:

 - Selecting folders or files with one command in the Windows Explorer folder pane or details pane.
 - Entering the search text and executing the search in a single step in various search boxes such as Google
search or the e-mail search box available in Yahoo! Mail.
 - Entering terms with a single command in text entry boxes that support auto complete such as the To: field
of various e-mail clients such as Lotus Notes or Yahoo mail.

16. EASILY NAVIGATING BY VOICE TO YOUR BOOKMARKS/FAVORITES

Use the program "X marks" to keep your bookmarks synchronized between your Firefox browser and your
Windows favorites. Once you have that running in the background then you can easily navigate to your
bookmarks by voice by saying "start menu" -> "favorites" -> etc. Assuming that you have set Firefox as your
default browser, these bookmarks will automatically open in Firefox.

Also note that you can easily define custom commands in Dragon's Command Browser that can navigate
through series of menus from the start menu and land you in a specific folder within your favorites, or in a
specific folder within your "my documents".

16B. MANAGING ONLINE PASSWORDS

Utter Command provides a very useful extension called "UC tab list" where you can associate certain
keywords with certain text and use it to quickly fill forms online, including passwords. So, to the extent that
you only have four or five passwords that you use regularly, and to the extent that you secure your computer
with a password and automatic lock after a period of inactivity, this is a sufficient password manager at least
for your noncritical passwords.

For more involved and secure password management I like to use this software called Roboform which offers
some very extensive features. Because it places a toolbar to a standard place within Firefox you can train
Utter Command to automatically fill in the passwords with a simple command that always refers to the same
region in Firefox where the password appears.

17. ORGANIZED COLLECTIONS OF KEYBOARD SHORTCUTS

http://www.shortcutmania.com/index.htm

18. CLOSE MULTIPLE APPLICATION WINDOWS SIMULTANEOUSLY

Use the following utility:

http://www.nirsoft.net/utils/nircmd.html

which provides a command line allowing you to selectively close some or all of the application Windows that
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are open. For example, you can close all the window Explorer Windows with the following command:

nircmd.exe win close class "CabinetWClass"

Put that in a batch file, and then train a custom NaturallySpeaking command such as "Windows Close All"
that executes said batch file.

Similarly, the following command line:

NirCmd.exe win close AllTopNoDesktop

will close all open applications, while allowing you to manually answer yes/no to any application that brings
up a dialog box, e.g., because a document has not been saved. There is also a variation that will force a
yes/no/cancel answer:

nircmd.exe win dlgclick class "#32770" no

All of the above commands can be applied to different classes of application Windows, e.g., you could
specify them so that they close all of the Sumatra PDF reader Windows, or all of the Microsoft Word
Windows. To do that, you will need to know the class of these windows which you can find easily by using
another utility from the same author:

http://www.nirsoft.net/utils/winlister.html

The utility works with Windows 7. By taking advantage of information it provides, you can now easily have at
your disposal the following custom commands: "Firefox/notepad/word/excel/etc. Close All". Note for Utter
Command users: this would be slightly different than the command "Word Close", which only closes one
window time. The version shown here will close all open instances of this elected application while also
allowing user to reply to any dialogs that pop up, e.g., for saving unsaved documents.

19. SHARING SCREENSHOTS OR IMAGES OF PART OF THE SCREEN

I use the snagit screenshot software and I find it to be quite speech friendly using the Utter Command mouse
control interface. Also, the screenshot software has nice keyboard shortcuts that are even customizable.
Here is a sequence of commands that quickly places an image of part of your screen to your clipboard:

Press printscreen
10 x 20 no touch
drag 30 x 40
Shft Cntrl Charlie

20. DICTATING WORDS THAT ARE ALSO COMMANDS

Say you want to dictate the word "cancel" or the word "end". Unless this is done in the middle of a sentence
with continuous dictation, Dragon is likely to interpret them as commands. To avoid this confusion when
dictating such a word start by saying something like "no space" and then followed by the intended word.

21. PLASTER CHECKLISTS ALL AROUND YOUR MONITOR

Your monitor screen has four sides, and you should take advantage of that real estate to plaster it with
checklists containing useful commands or speech shortcuts. In addition to various cutouts that I have
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collected from the Utter Command documentation, I also maintain my own personal cheat sheet file (seven
columns on legal paper), and my own personal vocabulary list of custom words I have added.

And, on half the screen of my second monitor I always have open the UC list window, which is essentially
each own collection of 10 checklists arranged by tabs which are voice-enabled.

22. SPELLING WITHOUT THE QUIRKS OF DRAGON'S SPELL COMMAND

Dragon's spell command often has unpredictable results depending on the type of window where it is being
used. UC offers a completely stable alternative for up to three letters, e.g., "Letter Zulu Alpha Papa".

23. CUSTOMIZATIONS FOR DIFFERENT SOFTWARE

23.1. MICROSOFT OFFICE 2003/2007

While 2003 remains to date my all-time favorite and easiest to use version of Microsoft office, I am sorry to
report that I was never able to get it to work quite right with Windows 7. Office programs would have huge
delays before starting, and would also crash quite frequently. All these problems went away when I upgraded
to Microsoft Office 2007.

My major problem with the 2007 version is that the old menus have been eliminated and have been replaced
by the annoying, hated ribbon, which I recommend setting to auto hide (choose "Minimize").

There are two main issues with the ribbon as opposed to the original menus:
- there are fewer commands and options that can be accessed by navigating through the ribbon tree than
there where through the menu tree
- learning keyboard shortcuts was much easier and cleaner by following the underlined letters in each menu
item, rather than trying to follow the cramped "hints" that appear in the ribbon once you initiate the keyboard
shortcut process by saying "Press Alt"

So, it has now become much harder to learn new keyboard shortcuts for actions that you start using
repeatedly and which are not part of the ribbon, such as "Alt+i+b+c+Enter" which is the keyboard shortcut for
entering a section break. With Utter Command you would be able to do this with a single fast command
("Under India Bravo Charlie Enter"), so the original menus were great help in learning the sequence of
keyboard shortcuts.

Thankfully, the 2003 keyboard shortcuts still work. Also, a variety of third-party add-ins simulate the classic
menus from the 2003 version as part of the ribbon in the 2007 version:

http://www.techrepublic.com/blog/five-apps/five-add-ins-for-users-who-hate-the-office-ribbon/1152

I have tried a couple of these, but I have found that the menu trees are not always faithfully replicated.
However, if you're determined to stick it out with Microsoft Office 2007 or later, I do recommend the final
add-on listed on the website above. It's called "Search Commands" and it's by Microsoft. It gives you a new
ribbon component with a search box for locating commands.

Personally, I am going to keep fighting my computers until Microsoft Office 2003 can work without issues with
Windows 7. Online forums suggest that a lot of people have managed to do this.
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23.2. BLOOMBERG TERMINAL

The Bloomberg terminal is very speech friendly because all Bloomberg functionality can be navigated using
the numbers associated with each link, much like mouseless browsing in Firefox.

By coincidence, the numerical entry commands that are provided by Utter Command for working in Microsoft
Excel are also an extremely convenient interface for navigating the Bloomberg terminal. For example, to click
on the link with number forty-six you simply say "4 6 Enter Short".

The way the Bloomberg terminal works is that you enter a Bloomberg command, e.g., "MSG", followed by
pressing the enter key. Even without programming any voice macros, there are a couple of easy ways for
creating your own set of commands:

. Use the Utter Command wizard to train a bunch of different "Enter commands". This is by far the easiest
way. For example, I have created my most frequently used commands such as "Blue Message", "Blue
Describe", "Blue Top", etc.

. Use Dragon's own vocabulary training to train each command, and then go to the Properties dialog to
specify that it is followed by a newline. If you would like to avoid this Properties step simply used the trick
described above for avoiding hitting the "Enter" key.

23.3. X1 DESKTOP SEARCH (version 6.7.4, formerly Yahoo desktop search)

This is a very UC friendly interface, with clear locations on the screen for modifying search options (using the
UC local tool). I find it much easier to locate and open documents with this desktop search software rather
than with the Windows 7 built-in file search which I have disabled. It allows you to predefine and save
specific search templates, e.g. PDF files in a specific directory. You can then add the location of these files to
the UC file interface so that you can execute very complicated searches with a single voice command, e.g.,
"search work PDF File" or "search sports bookmarks File".

23.4. STATA (confirmed for version 11)

Use Microsoft Word 2003 as a Stata programmers editor by programming regular expressions in VBA so let
your code can be color-coded, especially for comments. See section "Select-And-Say Enabled Programmers
Text Editor with Highlighting" above.

Use AutoIt to emulate the "F9" functionality of Matlab, where you simply have to select some code in your
favorite editor and you press a button to have it executed automatically in Stata. You can then bind this
executable to a custom voice command in Dragon so that all you have to do is select some code and say
something like "run this". Here is a good online guide for how to do this:

http://huebler.blogspot.com/2008/04/stata.html

Build your own custom vocabulary of Stata commands, for example you could train the word "tssmooth ma"
to be recognized by Dragon when you say "my moving average".

For a voice-enabled Stata help site you can use the website help for Stata version 11 by pointing Firefox to
the following address "http://www.stata.com/help11.cgi?", and making sure that the blinking cursor is at the
end of the line in the address bar (SendKeys "{Alt+d}"; SendKeys "{End}"). You can then navigate to the help
page you need by calling out the command you're interested in using the trick described above in section
<Eliminating the "Enter" Step for Certain Actions>, e.g., you could say "regress New Line".
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The help file for the command will be shown as a webpage, including links to related commands and related
sections that you can navigate by voice using mouseless browsing. Note that the links to related commands
are not available for version 12 help online. Finally, you may want to program your own custom voice macro
so that every time you say the command "Stata Help" your Firefox browser will open up automatically to the
above address (done very easily with Utter Command, not sure how you would do it otherwise) and put the
blinking cursor at the very end of the address line, so that anytime you need help or you would have to do is
say "Stata Help", "regress New Line".

23.5. LOTUS NOTES (confirmed for versions 7.0 and 8.5)

Speed up Lotus Notes response time to allow for sequence of keyboard shortcuts as used by Utter
Command: Change the Notes shortcut to load the basic release rather than the full eclipse release, by
changing the shortcut target in the Lotus Notes icon from

c:\notes\notes.exe "=c:\notes\notes.ini"
            ->
c:\notes\nlnotes.exe "=c:\notes\notes.ini"

If you use the full eclipse release then Lotus Notes becomes too sluggish to react to voice macros that work
via keyboard shortcuts.

Prevent the instant messaging contact list window from popping up every time you start Lotus Notes
automatically: It is one of the options available in the drop-up menu that pops up when you click on the arrow
in the "I am active" box in the toolbar at the very bottom of the Lotus Notes window.

Maintain open tabs through different sessions: Click File - Preferences and look in the Basics tab. Click Save
windows state on exit. Click OK.

Have your inbox open in multiple windows: This is helpful if you need to keep track of different points in your
message list, e.g., the last e-mail you replied to, since it's very cumbersome in the Lotus Notes to quickly
scroll through screens of messages. The way to open a second window is to go to the inbox tab, and then
right-click on it says inbox on the left in the list of folders (approximate coordinates 11 x 22 when using Utter
Command). Then select the option "open in new window".

24. HIDE MOUSE POINTER

If you are annoyed with the mouse pointer stealing away focus, e.g., when you switch Windows you can try
the following solution which costs $20 for a noncommercial license with a 30 day evaluation.:

http://www.cursorhider.com/

I have tested it myself and it works well.

I use the following settings for optimal performance:
- "Quantity of Keystrokes to Hide Mouse Cursor": 0
- "Type of Hiding", "Manual Mode", "No Move, Only Hide" (Otherwise, mouse pointer movement commands
may have to be spoken twice to take effect.)
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